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Welcome to DataFlex Reports 2016 Developer Edition – 5.0.1 
 
Important Information – Please Read Carefully  
 
Existing reports  
The .dr (or .vrw for older reports) report definition format has changed between version 4.x and 5.x. If 
you save reports with this version of DataFlex Reports, you can no longer use them in previous versions. 
 
Special caution with regard to this: when opening reports made with an older version it is advised to run 
the ‘check database’ option. 
 
Existing workspaces with integrated reports 

If you have an existing DataFlex Reports 5.0 Beta I web project you should detach the old integration 
library and re-attach the library. This ensures that the JavaScript and CSS files are copied from the 
library to your workspace. 
 
DataFlex CodeJock controls  
DataFlex Reports uses the same version of the CodeJock components as DataFlex 18.2. If you uninstall 
DataFlex Reports you must manually run the ‘RegisterCodejockControls’ batch file in the DataFlex bin 
directory to ensure DataFlex 18.2 will continue to run correctly.  
 
Installation  
DataFlex Reports 2016 – 5.0.1 is developed with DataFlex 18.2. If you do not have a version 18.2 Client 
License running on your PC, the setup will automatically install one for you. 

 
DataFlex 16.0/16.1, 17.0/17.1 or 18.0/18.1/18.2 Studio license is required to use the Integration library 
which is part of DataFlex Reports 2016 Developer Edition.  
 
Supported platforms 

- Microsoft Windows 10 
- Microsoft Windows 8 excluding RT  
- Microsoft Windows 7 Home Premium or higher  
- Microsoft Windows Server 2012 including R2 
- Microsoft Windows Server 2008 including R2 

o All of the above are supported in 32 and 64 bit editions 

- Windows Terminal Services when using Windows Server 2012 or Windows Server 2008 
- Citrix XenApp when used in conjunction with other supported Windows operating systems  

 
Registration DataFlex Reports 5.0.1 will run as a 60-day trial version. If you start DataFlex Reports you 
will be asked to register your version. To register, you need to purchase a license. Registering will lift 
the trial period. After registering your license you have a 60 day period to activate your license. Make 
sure you have an internet connection, and simply confirm the activation. 
Click here to learn where you can order your license.  
 
Changes between 5.0 and 5.01 
Bug fixes: 

- Performance improvements for summaries - both summary fields and Sum() functions (see: 

http://support.dataaccess.com/Forums/showthread.php?58639-Enter-summary-s-exit-
speed&highlight=summaries) 

- Fixed problem with schema list not always showing all schemas (see: 
http://support.dataaccess.com/Forums/showthread.php?58991-DataFlex-Report-Writer-5-0-
Data-Source-problem&highlight=schema) 

- Fixed problem with Epson printer (see: 
http://support.dataaccess.com/Forums/showthread.php?59007-S-O-S-Epson-
LX&highlight=Epson) 

- Fixed table size/position not remembered in database expert (see: 
http://support.dataaccess.com/Forums/showthread.php?59080-DR5-Database-Expert-Table-
Links-weird-behaviour&highlight=database+expert) 

- Fixed problem with fonts not being embedded in PDF export (see: 

http://support.dataaccess.com/Forums/showthread.php?59072-Barcode-printing-
Free3of9&highlight=PDF+export) 

- Fixed problem where only the first two expressions of a filter function are used for offloading 
(see: http://support.dataaccess.com/Forums/showthread.php?59141-DR5-Report-Filters-
Pain&highlight=filter) 
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- Fixed rare problem where sections did not always appear in preview (see: 
http://support.dataaccess.com/Forums/showthread.php?59139-Missing-Records-
Revisited!&highlight=margin) 

- Fixed problem with CodeDescription (CodeMast) ELF not working when used with .INT files (see: 
http://support.dataaccess.com/Forums/showthread.php?56381-DR4-02-Can-t-open-Codemast-
table&highlight=codemast) 

- Fixed problem with embedded images (see: 
http://support.dataaccess.com/Forums/showthread.php?59071-Hitting-some-memory-limit-
amp-crashing-during-report-design) 

- Fixed typo and casing of build-in function names in the function editor 
- Fixed problem in field properties where the image location was not being saved after using the 

prompt button to select an image 
- Clicking the ‘Cancel’ button on the SQL statement dialog no longer clears the statement 
- Fixed memory leaks 
- Tables without an alias name retain their existing (alias) name when using the ‘Change 

Datasource’ wizard 
 
Library: 

- cDRReportHelper.pkg 
o New package cDRReportHelper.pkg. This file contains the cDRReportHelper class 

containing the DateTimeToString, DateToString and TimeToString functions. In version 
5.0 and older these functions were part of the cDRReport class. They are still there for 
backwards compatibility but redirect to the functions in an automatically created child 
object named oDRReportHelper. This way the functions can be used in DataFlex 
components that don't contain a cDRReport object. The integration wizard generates an 
object of the cDRReportHelper class in components that don't need a cDRReport object 

- DRExportOptions.dg 
o PDFType combo added to the oDRExportOptionsDialog object (in DRExportOptions.dg) 

- cDRReport.pkg 
o When using preview to a MDI view (cDRPreview) or a toolpanel (cDRToolPanelPreview) 

the results were not refreshed if the preview window wasn't closed before changing 
selection criteria and executing the report again 

 
Wizard Changes: 

- The wizard now supports reports not using a filelist as database but individual tables 
- When using an ODBC report the wizard checks if the tablenames used matches the data-

dictionaries defined in the workspace and generates DDO's and code to use these 
- The wizard now sets piColumnCount for the SortOrderGroup in a web component 

 
Changes between Release Candidate and Release 
Bug fixes: 

- Increased the maximum image size in RDS tables 
- Fixed problem with size of docking panes in RDS sample dialog 
- Fixed problem with explorers not always working 

 
Changes between Beta II and Release Candidate 
Bug fixes: 

- Information message if the selected printer bin is not supported by the printer 
- Fixed problem with ‘Hide section’ not working 
- Stored procedures did not appear in the list when using an ODBC datasource 
- Background color of boxes do not show in the designer 
- Fixed problems with explorer panes appearing in the top-left corner 
- ‘Function name’ combo was not initialized in the ‘Library function’ (ELF) dialog 

- Current connection in Database Expert did not show schemas for ODBC connection 
- Varchar(max) fields did not show any data when running the report 
- Left & Right arrow keys did not work when field was (partially) outside the page borders 
- Fixed problems with field masks not working 

 
 
Changes between Beta I and Beta II 
New features: 

- Support for PDF/A export. When creating a PDF/A the following options are prohibited and an 
error message is generated if the report contains any of the following: 

o Alpha channels (transparency) – for example an image with transparency or a gradient 

o Passwords (both user and owner passwords) 
o An image with an unsupported – embedded – ICC profile 
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- ‘Wrap text’ option added to the field properties. If this option is not set the object is always 
formatted in a single line. With this option set the text will wrap and as many lines as can fit in 
the object rectangle are displayed.  

Bug fixes: 
- Numerous fixes in the Integration library wizards and JavaScript/CSS files 
- Fixed problem with ‘overlay next section’ (HDE 4317) 

- Using the ‘Cancel’ button in the ‘SQL Statement’ generated an ‘invalid argument value’ error 
(HDE 4307) 

- Double click on ‘SQL Statement’ treeview item in the ‘Database expert’ did not start the dialog 
(HDE 4306) 

- Adding a field to a label report using the ‘Field explorer’ would add a Field Heading label - if the 
option was selected (HDE 4299) 

- The ‘Section Expert’/’Report Explorer’ and other dialogs included all sections for label reports – 
however a label report only has a details section (HDE 4300) 

- ‘Array index out of bounds’ error when creating a label report using the wizard without selecting 
any fields for the report (HDE 4298) 

- A sub-report inside a – blank - section with the option ‘Hide blank section’ set would not show 
the sub-report (HDE 4296) 

- Fields in the details section of a sub-report created with the wizard would be placed on top of 
each other (HDE 4294) 

- Field Heading labels would not be included when creating sub-reports using the wizard – even if 
the option was selected (HDE 4295) 

- ‘Stack overflow’ error when running a report with summaries on large number of records (HDE 
4277) 

- A groupname based on a function does not display contents (HDE 4162) 
- Rename of a function using the field explorer can duplicate the function name (HDE 4095) 
- Export to PDF and RTF of a box with the border set to ‘none’ does displays box borders (HDE 

4089) 
- Alignment does not work when one of the objects is locked – using the ‘Allow move/resize of 

locked fields via keyboard’ option enables alignment of locked objects (HDE 3890) 

- Bottom pixel was clipped when export to PDF – low quality (HDE 3284) 
- 0.5 point lines and boxes did not appear in HTML export, other non integer line thickness would 

be rounded down to nearest integer (HDE 3284) 
- Horizontal/Vertical position and Width/Height fields in the ‘Field properties’ dialog are incorrectly 

rounded down. 
- Mask fields are incorrectly initialized in the ‘Field properties’ dialog when using a Custom 

number or Currency mask 
 
Changes between Alpha and Beta I 
New features: 

- Support for mobile devices has been added to the integration 

- DataFlex 18.2 integration library added 
- New chart types (Pie and Pyramid) are now available (see what is new in version 5.0) 
- Redesigned keyboard interface and new keyboard interface for moving and resizing to a 

guideline(see what is new in version 5.0) 
- Paper margins can now be changed from integration(see what is new in version 5.0) 
- New option ‘Allow move/resize of locked fields via keyboard’ added (see what is new in version 

5.0) 
 

Bug fixes: 
- Fixed error when deleting all horizontal guidelines 
- Fixed problem with Undo not working correctly 
- Fixed problems with moving horizontal guidelines 

- Moving guidelines now checks for negative size/position of objects 
- Fixed problem with RDS sample data dialog not showing first sample record (HDE 4237) 
- When printing all pages the selected tray is not respected if no tray was selected in the report 
- Fixed error when editing a function from the Field Explorer; after changing the name of the 

function an error 98 was triggered (HDE 4262) 
- When printing a report the background color of a section was printed in the wrong position - 

export and preview worked correctly (HDE 4260) 
  



What is New in version 5.0?  
 
Labels 
The new report wizard now has an extra option, to create multi-column label reports. It lets you define 
the correct format that can be stored in the repository for later use. Existing label reports can be easily 
changed via the Label tab in the Report Options. 

 

 
 



SQL Statement 

You can now directly enter a SQL statement – including parameters - for your ODBC reports. A 
parameter field will be automatically added to your report for every parameter you include in the SQL 
statement. 
 

 
 



New chart types 

Two new chart types have been added; Pie and Pyramid.  
 

 
  
 
Print section over multiple pages 

A new section option to allow sections to span multiple pages had been added to the section expert. 
 
Redesigned keyboard interface 
Moving and resizing objects using the keyboard has been redesigned to allow more intuitive use of the 
keyboard. New keyboard support for moving to a guideline (Alt+Arrow keys) and resizing to a guideline 
(Alt+Shift+Arrow keys) has been added. 
 
Miscellaneous 
ODBC Tables/Views etc. are now divided into schemas. 
Paper margins can now be changed from integration. 
New options: 

- Option to save a report on preview. 
- Option to allow moving and resizing of locked fields via keyboard. 

New section options: 
- Option to overlay next section. 
- Option to exclude a page footer section from the start of page footer. 

New field options: 
- Option to change the vertical alignment. 

Report options: 
- Option to print a report on alternate pages. 

 
  



Existing DataFlex Reports user information 

All classes, constants and files in the DataFlex Reports integration – included in this version – have been 

renamed as part of the rebranding of the DataFlex Reports product. For existing pre-DataFlex Reports 

4.0 applications create a backup of your existing project(s) and take the following steps to update to the 

5.x library: 

 

Remove the existing DataFlex Reports library and add the DataFlex Reports 5.x library to your 

workspace (this may require you to start the DataFlex Studio with administrator rights). 
 

1. Click the replace in files button in the Studio (Ctrl+Shift+H) 
a. Enter VRW in the “Text to Find” input field 
b. Enter DR in the “Text to Replace” input field 
c. Click the “Replace All” button 

2. Open the <projectname>.cfg file 

a. Replace all VRW with DR for the icons and bitmaps 
3. Search for the usage of psDatabaseCollate and remove the code. The property does not exist 

anymore 
4. Windows projects 

a. Replace all occurrences of “cCJSortColumnsGrid” with “cDRSortColumnsGrid” 
b. Replace all occurrences of “cCJSortDirectionsGridColumn” with 

“cDRSortDirectionsGridColumn” 
5. Web Application Framework projects 

a. Replace all occurrences of “oPDFModalDialog” with “oDRPDFModalDialog” 
b. Replace all occurrences of “Use PDFModalDialog.wo” with “Use DRPDFModalDialog.wo” 

6. Optional: 
a. Replace all “.vrw” to “.dr” in the program code 

b. Rename all reports with a VRW extension to DR            
 
 
Language support  
DataFlex Reports ships with support for a number of languages. Before changing the language used in 
DataFlex Reports you must set your Windows Regional Options to the language of your choice. This 
ensures that the correct (ANSI) code page is selected in Windows. You can change the Regional Options 
in the Windows Control Panel, for full language support you must change both the ‘Standards and 
formats’ option to ensure correct date and number handling and the ‘Language for non-unicode 
programs’ option. Please note that the name of these options may differ in various versions of Windows. 
After changing the Windows Regional Options you can change the language in DataFlex Reports by 
choosing a language from the ‘Language’ menu.  

 
Integration library  
DataFlex Reports comes with an Integration library. This library allows you to seamlessly integrate 
reports with your DataFlex 16.0/16.1, 17.0/17.1 or 18.0/18.1/18.2 applications. The library contains an 
Integration Wizard and classes for integrating and viewing reports. During installation you can specify 
the location of the Integration library. We suggest you install the library in a subfolder of the main 
DataFlex directory, this allows you to add the library using relative paths. To use the Integration library 
and Integration Wizard in your DataFlex projects and Workspaces you must first add the library. You can 
do this by opening the DataFlex Studio and select the ‘Maintain Libraries…’ option from the ‘Tools’ menu. 
Next, you can use the ‘Add Library’ button and open the ‘DataFlex Reports XXX.sws’ file. After selecting 
the .sws file and clicking the ‘Ok’ button a wizard will be started which will guide you through the 

process of adding the library to the currently selected workspace.  
For windows application, simply choose the ‘View/Report’ option from the ‘File’ menu and select the 
‘DataFlex Reports Wizard’ icon. For Web applications use the ‘Web Object’ option from the ‘File’ menu.  
 

Reporting bugs, comments and suggestions  

Please report bugs to support@dataaccess.eu, if you have a HelpDesk Express account you can also 

enter reports directly at http://hde.dataaccess.eu. Make sure to provide as much detail as possible to 

define and reproduce the problem that you are reporting. Upon your report, you will be invited to use an 

account on our help-desk support system for reporting future issues. For further communications and 

information, there is a forum devoted to DataFlex Reports in the Data Access Worldwide Support 

Forums. 
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